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TECHNICAL BACKGROUND —  EFFECTIVE INDEX METHOD
Effective Index method
Among the numerical and approximate methods in waveguide analysis, the effective-index 
method (EIM) is probably the most popular method for analysing integrated optical devices.  
The basic idea of the method is to replace the structure found in the transverse plane (a 
rectangular waveguide or rib waveguide) by an equivalent one dimensional slab with effective 
refractive indices.  This transformation reduces the two-dimensional transverse cross-section 
of the device refractive index to a one-dimensional one.  Therefore, there are two steps in the 
Effective Index Method (EIM).  The first step is to find the fundamental modal index of the 
waveguide along the y-axis (perpendicular to the propagation) and the second is to analyse the 
resulting 2D structure (x axis and the propagation direction z) using the 2D Beam Propagation 
Method (BPM). The following diagram illustrates these two steps.

Figure 1 Effective Index Method — two steps
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TECHNICAL BACKGROUND —  EFFECTIVE INDEX METHOD
Note that the sense of the principal direction changes from the first to the second step.  
Therefore the  simulations for the first and second steps should be done with the opposite 
polarization (TE or TM).  The following table describes the polarization condition in the EIM, 
depending on the initial polarization.

As only the solutions for slab waveguides are required, the EIM is significantly more efficient in 
terms of CPU time than the full 3D methods that solve the waveguide structure directly.  The 
effective index method works very well for weakly guiding devices and when the modes of the 
waveguides are in the far-from-cutoff region.  The effective index method can be applied both 
for mode solving and beam propagation simulations.  Among the most popular introductory 
references regarding the EIM are:

[1] Marcuse, D., "Theory of Dielectric Optical Waveguides, Second Edition," Boston, 
Academic Press, 1991.

[2] Chiang, K.  S., "Review of numerical and approximate methods for the modal analysis of 
general optical dielectric waveguides," Optical and Quantum Electronics, vol.  26, 1994, pp.  
S113-S134, Sections 7.2 and 7.3.

The WDM_Phasar software package is based on the EIM.  The program combines the 
advantages of the 2D Beam Propagation Method (BPM), mode solving, and waveguide bend 
loss simulations in a comprehensive way to analyse Phased Array Wavelength Division 
(De)Multiplexers (Phasar Arrays).

IF initial polarization state TE TM

THEN

Effective index: Step 1 (modal) along Y TE TM

Effective index: Step 2 (BPM 2D) in X–Z TM TE
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TECHNICAL BACKGROUND —  WEIGHTED INDEX METHOD
Weighted Index Method
The effective index method is useful for reducing the complexity of the calculations by 
eliminating one of the transverse axes.  However, a problem occurs when the conditions in the 
cladding do not allow a guided mode.  This condition is likely to occur in buried waveguides, or 
rib waveguides where the majority of the light energy is confined to the rib.  In these cases, 
matching the boundary conditions of the mode profile in the cladding substrate will make it 
impossible to match the boundary conditions in the cover layer, as illustrated below:

Figure 2 Problem — what if nI does not exist?

The whole idea of EIM is to match these vertical modes at the boundaries of the rib, so the 
simple implementation of the EIM will fail if no such vertical mode exists in the cladding layers 
outside the rib.  

In the WIM (Weighted Index Method), the same basic idea of the EIM is used: to replace the 
rectangular structure by an equivalent slab.  The difference is in the way the effective indices of 
the slab are defined.  In the WIM, a one dimensional field profile is found from the centre line of 
the rib.  This profile is then used as a weighting function applied to the refractive index 
distribution found outside the rib.  These two slab indices are then used in an equivalent 
horizontal index distribution to make up a horizontal field distribution.  This first step of the WIM 
is illustrated below.
5



TECHNICAL BACKGROUND —  WEIGHTED INDEX METHOD
Figure 3 WIM — first step

The WIM is an iterative method.  At the end of the steps described above, the horizontal field 
distribution can be used as a weighting function for the horizontal layers in the rib.  This leads 
to a new definition of the vertical layers, different from the values on the centre line which were 
used in the first step.  Using these new values for the horizontal layers, a new vertical field 
distribution is defined, which will define new weights for the vertical (effective slab) layers, as 
shown below 

Figure 4 New weights for vertical layers

In this way a loop begins, and after a few iterations the loop converges.  It is the values of the 
indices after convergence that are used in the WIM.

The utility of EIM and WIM for WDM_Phasar is that they implement the basic idea of the 
effective index (to replace the 2D picture of the transverse plane with a 1D model).  The 
advantage of the WIM over EIM is that WIM may be used for a greater range of waveguide 
structures.  Furthermore, in the case where the light energy is more confined to the rib, the 
numerical value of the modal index calculated by WIM is more accurate.  See the following 
references for more details on WIM
6



TECHNICAL BACKGROUND —  WEIGHTED INDEX METHOD
References

[1] Kendall, P.C. et al, "Theory for calculating approximate values for the propagation 
constants of an optical rib waveguide by weighting the refractive indices", IEE Proceedings, 
134(8), p699-702 (1987)

[2] Benson, T.M. and Kendal, P.C., "Variational techniques including effective and weighted 
index methods", in  Progress in Electromagnetics Research, No. 10, (EMW Publishing, 
Cambridge, Massachusetts, USA, 1995)
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TECHNICAL BACKGROUND —  BPM 2D
BPM 2D
The EIM reduces real three-dimensional (3D) waveguide devices like phasar arrays to two-
dimensional (2D) structures.  The BPM solving engine simulates the light propagation in the 2D 
device.  The simulation process is a step-by-step propagation in the direction defined as the 
propagation direction, Z.  Since the geometry of the phasars (especially the Dense WDM 
devices) can be very complicated, a global propagation direction cannot be defined.   Moreover, 
the BPM algorithms have limitations in the analysis of waveguides whose path has a large tilt 
angle with respect to the propagation direction.  Therefore, the BPM has been used to simulate 
only some parts of phasars.  BPM is still used in the slab (Free Propagation) regions, the 
input/output channels and the array waveguides in the sections where the coupling cannot be 
neglected.

In the BPM simulations, we consider only monochromatic light that is described by an 
electromagnetic wave with a single frequency.  The optical waveguides and waveguide devices 
are defined by a spatial distribution of the refractive index.

The propagation of the coherent field E(x,z) is governed by the 2D Helmholtz equation.  In 
actual simulations, we use paraxial or wide-angle approximations to the Helmholtz equation.

The following is the paraxial Fresnel equation that is an approximation of the Helmholtz 
equation, valid for small angles of propagation:

(1)

The Fresnel equation is expressed with the help of the paraxial propagator P. This propagator 
P can be formulated as scalar, or vector with a reference to polarization corrections.

The paraxial scalar propagator in 2D is:

(2)

where k is the vacuum wavenumber, n (x,z) is the refractive index distribution, and nref is the reference 
index.

∂
∂z
-----E x z,( ) i

2knref
---------------PE x z,( )=

PE x z,( ) ∂2

∂x2
--------E x z,( ) k2 n2 nref

2–( )E x z,( )+=
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TECHNICAL BACKGROUND —  BPM 2D
The following is a vectorial propagator, which has polarization corrections due to dielectric 
interfaces:

(3)

For wide angles of propagation, the model is improved by adding corrections based on Padé 
approximations.  Solvers based on higher Padé approximations also allow for simulations of 
structures with larger refractive index contrast.  The wide-angle equations are built with the help 
of the propagator P.

The Wide-Angle Padé(1,1) propagation equation in 2D is the following:

(4)

The Wide-Angle Padé(2,2) propagation equation in 2D is the following:

(5)

PE x z,( ) ∂2

∂x2
--------E x z,( ) k2 n2 nref

2–( )E x z,( ) ∂
∂x
------ 1

n2
----- ∂

∂x
------ n2E x z,( )( )+ +=

∂
∂z
-----E x z,( ) i

2knref
--------------- 1 P

4k2nref
2

-----------------+
1–
PE x z,( )=

∂
∂z
-----E x z,( ) i 3P

4k2nref
2

----------------- P2

16k4nref
4

--------------------+
1–

1
2knref
--------------- P

4k3nref
3

-----------------+
1–
PE x z,( )=
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TECHNICAL BACKGROUND —  FINITE-DIFFERENCE METHOD
Finite-Difference Method
The above listed paraxial Fresnel equation and the Wide-Angle Padé propagation equations 
can be solved using different numerical approaches.  Our BPM was built in the frame of the 
Finite-Difference Method (FDM).  The refractive index distribution of the device and the 
propagating optical field should be discretized in both transverse and longitudinal directions.  A 
central difference numerical scheme is used to represent the derivatives with respect the 
transverse co-ordinate x and a Crank-Nicolson method is employed for the propagation.  The 
propagation is performed in a step-by-step fashion.

In the transverse direction, the solution domain is bounded by the mesh window.  In the 
propagation direction, the domain is limited by start and end propagation distances.  We impose 
the optical field at the start position, while the BPM finds the field at other distances.  Boundary 
conditions are used for finding the field at the transverse boundaries.  A physical condition that 
allows the optical field to radiate out from the computational domain is called the transparent 
boundary condition, or TBC.

References

[1] Yevick, D., "A Guide to Electric Field Propagation Techniques for Guided-Wave Optics", 
Optical and Quantum Electronics, vol.  26, 1994, pp.  S185-S197.

[2] Hadley, G.  R., "Wide-angle beam propagation using Padé approximant operators", Optics 
Letters, vol.  17, No.  20, 1992, pp.  1426-1428.

[3] Hadley, G.  R., "Transparent Boundary condition for the beam propagation method", IEEE 
J.  Quantum Electronics, vol.  28, No.  1, 1992, pp.  363-370.
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TECHNICAL BACKGROUND —  SLAB WAVEGUIDE MODES
Slab Waveguide Modes
The TE and TM modes of a slab waveguide can be determined by solving the eigenvalue 
equation for the corresponding polarization.  Later the nonzero-field component distributions 
can be found.  The slab waveguide modes are the modes of the one-dimensional structure 
obtained via the Effective Index Method.  More details about the slab mode solving are given in 
the chapter describing the Wizard Tool features.

Phase Accumulation

The phase accumulation is an important process responsible for the tilt of the phase front in the 
array of waveguides.  The light signal at the end of the k-th waveguide in the array can be 
described by the complex amplitude Ak:

(6)

Where Ao
k is the initial signal amplitude,  is the initial phase, Lk is the length of the k-th waveguide, 

and  is the modal index of the propagation (TE or TM mode).

The neighbour waveguides in the array have a certain length difference designed in such a way 
to produce a phase difference which is some multiple of  for the central frequency fc:

(7)

where m is the order of the array. Therefore, after propagation through the array, there will be no tilt of 
the phase front.  

If the signal frequency (f) is different from the central one fc, there will be a frequency dependent 
phase accumulation  for each waveguide from the array:

(8)

After propagation through the array, the phase difference between the signals in the array will 
result in a frequency (wavelength) dependent tilt of the phase front before the propagation starts 
in the output free propagation region.  This tilt will be responsible for the shift of the position of 
the signal in the focal plane as the wavelength changes.

Ak Ao
k iϕo– iβ f( )Lk+[ ]exp=

ϕo
β f( )

2π

β fc( )Lk 1+ β fc( ) Lk ∆L+( ) β fc( )Lk 2πm+= =

ψ f( )

β f( )Lk 1+ β f( ) Lk ∆L+( ) β f( )Lk 2πm ψ f( )++= =
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TECHNICAL BACKGROUND —  SLAB WAVEGUIDE MODES
Power Overlap Integral
The power overlap integrals provide very important information.  First, they show how much 
power from a propagating light signal with any distribution can be coupled to a given guided 
mode of a waveguide.  Second, the overlap integrals provide important information about the 
cross-talk level.  More details about the Power Overlap Integral are given in the section 
describing the cross-talk level estimation in the Chapter regarding the Wizard Tool.

Waveguide Bend Loss 

When guided light goes around a bend, the phase front will need to move more quickly at the 
outside of the bend than the inside.  Following this trend to greater radii will lead to a point where 
the phase velocity of the guided mode is equal to the velocity of unguided light in the substrate.  
The matching of velocities here makes the opportunity for the guided light to couple to unbound 
radiation modes.  This mode conversion is the physical origin of optical loss on bent 
waveguides.  Since a typical Dense Wavelength Division (De) Multiplexer with Phased Array 
geometry employs a number of waveguides with an arc shape, the simulation of the bend loss 
is an important part of the device analysis.  There are many methods to evaluate the bend loss, 
which include the BPM with or without conformal mapping of the refractive index.  The method 
implemented in the WDM_Phasar simulator is a trade-off approach, which combines very high 
simulation speed with a reasonable accuracy.  This method has been described in 

[1] Marcuse D., "Bending Losses of Asymmetric Slab Waveguides", The Bell System 
Technical Journal, vol.  50, (1971), pp.  2551-2563.

According to the above-listed reference, if an optical signal with input amplitude Ain propagates 
in a bend with radius of curvature R and length l, the output amplitude Aout will be given by:

(9)

The loss coefficient a can be found from the following expression:

(10)

Aout Ain α l–( )exp=

α γs2 γd( ) U–( )expexp
k2β nco

2 ncl
2–( ) d 2 γ⁄+( )

----------------------------------------------------------=
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TECHNICAL BACKGROUND —  SLAB WAVEGUIDE MODES
Where:

(11)

(12)

(13)

The rest of the parameters are:

The way to evaluate the bend loss described above is applicable only when both conditions 
listed below are fulfilled:

(14)

d waveguide width

nco core effective index

ncl cladding effective index

propogation constant of the unbent slab

k wavenumber

R radius of curvature of the bend

U β
γ
---1n

1 γ
β
---+

1 γ
β
---–

------------ 2–

 
 
 
 
 

γR=

γ β2 ncl
2 k2–( )

1 2⁄
=

s nco
2 k2 β2–( )

1 2⁄
=

β

15



TECHNICAL BACKGROUND —  SLAB WAVEGUIDE MODES
β nclk 1 d
2R
-------+ 

 <

β nclk 1 d
2R
-------– 

 >
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TECHNICAL BACKGROUND —  PROPAGATION CONSTANT OF BENT WAVEGUIDES
Propagation constant of bent waveguides
As mentioned in the previous section, light going around a bend must have a local phase 
velocity that increases with the radius.  It is by advancing the phase at the outer radius that the 
direction of the propagation is modified.  A suitable model of this situation is to compare with a 
straight waveguide which has a linear increase of refractive index superimposed on the 
waveguide refractive index profile.  This perturbation to the refractive index distribution distorts 
the optical wave, and changes the propagation constant slightly.  Since phasar devices use long 
bent waveguides having various bend radii, this small change in propagation constant might 
sometimes be significant to the final phase presented to the output coupler after the light passes 
through the phasar array.  Therefore the change in propagation constant due to bending is 
included in WDM_Phasar.  The change is estimated by a second order perturbation theory as 
described in the following paper:

[1] Garth, S.J., "Modes on a bent optical waveguide", IEE Proceedings, 134(4) Part J, p221-
229 (1987)

Optimum Offset 

In a bent optical waveguide, the outside of the bend has the higher phase velocity.  Therefore 
in the perturbed index model of a bent optical waveguide, the side corresponding to the outside 
of the bend must have a higher index of refraction.   The effect on the optical field is to shift the 
field toward the outside of the bend, in a way similar to the change in electronic wavefunction 
in response to the Stark Effect.  The mismatch of the field shapes can lead to losses at the 
junction between straight and curved waveguides.  These losses can be minimised by 
introducing an offset at these junctions, as shown below:

Figure 5 Introducing an offset at junctions

The value of the optimum offset is estimated by finding the maximum of the perturbed field.  
Within the approximations used in WDM_Phasar, waveguides set with this optimum offset have 
negligible losses at the junctions.
18



TECHNICAL BACKGROUND —  PROPAGATION CONSTANT OF BENT WAVEGUIDES
Bent/Straight Junction Loss 
In the case where the optimum offset is not used, the waveguides are continuous across the 
bent/straight waveguide junctions, and some small loss can be expected from the mismatch of 
the shapes of the modal fields.  To the approximation used in WDM_Phasar, the field of the bent 
waveguide is the same as the straight one, but only displaced according to the Optimum Offset 
as described in the above section.  The calculation of the resulting loss is then the same as the 
calculation of crosstalk using overlap integrals, and WDM_Phasar estimates the junction loss 
in the same way.

Wizard Tool

The idea behind the Wizard is to provide a tool which will compute the basic geometric 
parameters of the Phasar, based on some requirements for the performance of the device.  The 
most important requirements are: the maximum cross-talk level, maximum loss, channel 
spacing, and level of the transmitted power.

The evaluator consists of the following main modules:
• 2D Mode solving
• Crosstalk level
• Free propogation region
• Array waveguide length increment and order of the array
• Aperture width and the number of array waveguides

2D Mode solving

The fundamental TE and TM modes of a symmetric slab should be found first.  This will 
determine the input/output waveguide minimum separation as well as the separation of the 
array waveguides.  In this way a predefined maximum cross-talk level is ensured.

The eigenvalue equations for the TE and TM modes of a symmetric slab are, respectively:

(15)

where the parameters involved are:

d waveguide width

n1 core effective index

n2 cladding effective index

ud 2⁄( )tan γ u⁄=

ud 2⁄( )tan
n1

2

n2
2

-----γ u⁄=
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TECHNICAL BACKGROUND —  PROPAGATION CONSTANT OF BENT WAVEGUIDES
(16)

(17)

Cross-talk level

Using the modal fields and a predefined maximum crosstalk level (CTMAX), the minimum 
separation between the centres of two neighbouring input/output channels (dr) and two array 
waveguides (da) can be estimated.  The crosstalk level in dB is related to the power overlap 
integral Pover:

(18)

The power overlap integral by itself can be defined as:

(19)

where ds is the separation (dr or da), E1 and H1 are transverse electric and magnetic components for the 
fundamental mode of the first waveguide that are different from zero (Ey and Hx for TE modes, and Ex 
and Hy for TM modes).  E2 and H2 are the corresponding components for the fundamental mode of the 
second waveguide.

neff modal (TE or TM ) index

u 2π
λ

------ n1
2 neff

2–( )
1 2⁄

=

γ 2π
λ

------ neff
2 n2

2–( )
1 2⁄

=

CT dB( ) 10 Pover( )log=

Pover ds( )

0.5 E1
∗ H2 E2 H1

∗×+×( ) Ad
A∞∫ 

 
 

2

E1 H1
∗ z⋅×( ) A E2 H2

∗ z⋅×( ) Ad
A∞∫d

A∞∫
--------------------------------------------------------------------------------------------------------=
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TECHNICAL BACKGROUND —  PROPAGATION CONSTANT OF BENT WAVEGUIDES
In the case of equivalent waveguides, the following relations are valid:

(20)

Based on the above formulae, one can find the minimum distance of separation dsmin, which 
will ensure a maximum crosstalk level CTMAX.

Free propagation region

The minimum length of the free propagation region Ra
min can be estimated from the required 

value of the maximum acceptable access loss for the outer channel (or non-uniformity Lu).

(21)

where smax is the co-ordinate of the outer receiver defined by:

(22)

where N stands for the number of the output channels, and dr is the separation distance between the two 
neighbouring channels defined above.

The maximum acceptable dispersion angle  can be found using the Gaussian far-field 
approximation of the modal field.

(23)

E2 x ds,( ) E1 x ds+( )=

H2 x ds,( ) H1 x ds+( )=

Ra
min smax

θmax
-----------=

smax
N
2
----dr=

θmax

θmax
1

8.7
-------Luθo

2≈
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TECHNICAL BACKGROUND —  PROPAGATION CONSTANT OF BENT WAVEGUIDES
 is the width of the fundamental modal field of a single waveguide from the phased array 
given by:

(24)

The following parameters are involved in the formula above.

(25)

where E(x) is the distribution of the modal field.

Array waveguide length increment and order of the array

The array waveguide length increment  can be calculated based on the requirements for 
the dispersion D and the central operating frequency fc .

The length increment is given by:

(26)

The dispersion  is the lateral displacement ds of the focal spot along the image 
plane per unit frequency change.  The required dispersion can be found from the desired 
channel spacing  and the distance between the adjacent channels, , as .

nFPR effective index of the free propagation region

we effective width of the modal field given by the following expression:

θo

θo
λ

nFPRwe 2π
-----------------------------=

we

E x( )2 xd
∞–

∞+

∫

Emax
2

------------------------------=

∆L

∆L
DfcnFPR∆α

ñg
-----------------------------=

D ds df⁄=

∆f dr D dr ∆f⁄=
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TECHNICAL BACKGROUND —  PROPAGATION CONSTANT OF BENT WAVEGUIDES
The divergence angle  is the ratio between the distance between two 
waveguides  and the length of the free propagation region .  In the above formula, the 
group modal index that has been also involved is defined as:

(27)

where ng(f) is the modal index of the fundamental mode that is function of the frequency f.

The array order can be defined as:

(28)

Aperture width and the number of array waveguides

The angular half width  of the array aperture can be determined from the requirements for 
the transmission power level assuming an equivalent to a Gaussian far field.  The number of 
array waveguides Na is then given by:

(29)

∆α da Ra⁄=
da Ra

ñ ng f
dng
df

--------+=

m
∆Lfcng

c
------------------=

θa

Na 2θaRa da 1+⁄=
23



TECHNICAL BACKGROUND —  PERFORMANCE CALCULATOR
Performance Calculator
The Performance Calculator is a tool for the fast evaluation of the performance of a WDM 
device.  In a sense it is the opposite of the Wizard Tool, which computes the basic geometrical 
parameters of the Phasar based on some requirements for the performance of the device.  The 
Performance Calculator, on the other hand, estimates the Phasar performance by taking into 
account the geometric and material parameters of the device.

Crosstalk level 

Using the same approach as the one in the Wizard Tool, we can calculate the modal fields of 
two neighbouring output channels and find the overlap integral for a given distance of 
separation dr.  The maximum crosstalk level CTMAX can be determined using Equation 18, 
where the power overlap integral is defined by Equation 19.

Dispersion

The dispersion D of the array is described as the lateral displacement of the focal spot along 
the image plane per unit frequency change:

(30)

where, ñg is the group modal index defined by Equation 27,  is the divergence angle, nFPR is the slab 
effective index of the free propagation region, and fc is the central frequency.

Phasar and modified Phasar order

The order of the phased array m can be found using Equation 28, and the modified order of the 
phased array  can be defined as follows:

(31)

where ng and ñg are the effective index of the guided mode and the group modal index, respectively.

D ds
df
-----

ñg∆L
fcnFPR∆α
------------------------= =

∆α

m'

m' m
ñg
ng
-----=
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TECHNICAL BACKGROUND —  PERFORMANCE CALCULATOR
Nonuniformity
The nonuniformity Lu is defined as the intensity ratio (in dB) between the central channel and 
the outermost channel.  Using a Gaussian-beam approximation for the intensity of the far-field 
we can find the following dependence for the nonuniformity.

(32)

where the angle corresponding to the outer channel  can be found from Equation 21, and  is the 
width of the equivalent Gaussian far-field given by Equation 24.

Among the most detailed studies related to PHASAR design are listed in the references.

References
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WDM_Phasar Tutorials
The best way to learn how to work with WDM_Phasar is to do the Tutorial lessons. By following 
the step-by-step instructions, you will see how quickly you can become a highly efficient 
WDM_Phasar user.

Although you can use WDM_Phasar to perform a huge variety of tasks, in these introductory 
lessons you will learn how do the following.

• Effective index calculations
• Design a WDM device using the Wizard Tool
• Edit the WDM Device geometry
• Use the tools for fast evaluation of the WDM device performance
• Perform a parameter scan
• Run advanced calculations

The WDM_Phasar tutorial contains the following lessons and examples.

Lessons

• Lesson 1: Effective index calculations
• Lesson 2: Design a WDM device with the Wizard Tool
• Lesson 3: Editing the WDM device geometry
• Lesson 4: Tools for fast evaluation of WDM device performance
• Lesson 5: BPM simulation
• Lesson 6: Parameter scanning

Examples

• Example 1: Tapered waveguides in the phased array
• Example 2: Tapers in the output waveguides
• Example 3: Phased array corrections
• Example 4: Phased array with variable increment in the path length
• Example 5: Polarization independent device by splitting the input
• Example 6: Triangular region in the phased array
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COMPONENT LIBRARY  LESSON 1: EFFECTIVE INDEX CALCULATIONS
Lesson 1: Effective index calculations
In this lesson, you will use some of the options available in the Effective Index Calculator dialog 
box. You will learn to edit the default parameters of a multilayer ridge waveguide, to define the 
calculation parameters, and to perform the effective index calculations.

You will also learn how to calculate the modal indices of the guided modes and how to view the 
modal field distributions and the refractive index distribution of the waveguide.

Opening a new project

The first thing you will do is to open a new project. Then, you will define the parameters for the 
layers of a multilayer ridge waveguide. You will double-click each of the layers (starting from the 
bottom to the top) and enter data for each layer in the Layer dialog box.

To open a new project, perform the following procedure.

Step Action 
1 From the File menu, click New.

The Effective Index Calculator starts, and the first box in the sequence 
(Device Parameter Setup) appears (see Figure 1).

Figure 1 Device Parameter Setup dialog box
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• TIP: To open a new project, you can also click the New button (the first button on 
the Main Toolbar shown in Figure 2).

Figure 2 Main Toolbar

Defining the device parameters

To define the device parameters, perform the following procedure.

Step Action 
1 In the Device Parameters dialog box, type 1.5 in the Waveguide Width box.

2 In the Wavelength box, type 1.55.

3 In the Polarization section, enable the TE button.

4 Click the Edit Layers button to get to the next dialog box (see Figure 3).

Figure 3 Layer Structure dialog box
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This dialog box presents a picture of the cross section (transverse plane) of the waveguide to 
be used in the phasar array. The substrate is at the bottom, and the superstrate (cover layer) is 
at the top. The thickness of the top and bottom layer is not important to the calculation, as they 
are assumed by the calculation engine to extend to infinity.   They should be adjusted for the 
sake of convenient viewing only. The above Layer Structure dialog box shows an example of a 
rib waveguide.

In the Layer Structure dialog box, the widths and refractive indices of any layer can be changed 
by first selecting the layer with a single click and then clicking on Edit. (Double clicking on the 
layer will have the same effect.) Layers can be added or deleted by clicking on the appropriate 
button. You should modify the above example to model the waveguide you intend to use.

The above Layer Structure dialog box shows the default values supplied by the program. After 
you modify this structure, the program will automatically create an .ini file which will store the 
new structure you create. The next time you return to WDM_Phasar and run the Effective Index 
Calculator again, the latest structure you used will appear as the default.

Defining the parameters for a layer

To define parameters for a layer, perform the following procedure.

Step Action 
1 In the Effective Index Calculator dialog box, double-click the layer you want 

to modify.

2 In the Layer dialog box, type the desired thickness in the Thickness box (see 
Figure 4).

Figure 4 Layer dialog box

3 In the Layer Refractive Index section, type in the refractive index of the 
material in this layer. The layer section is the region outside the waveguide. 
For example, if this layer has been etched away, this value will be 1.00. 

4 In the Waveguide Refractive Index section, type the refractive index of the 
material in the waveguide section in this layer. In the top and bottom layers, 
the waveguide is not allowed, and for these layers this section will appear 
grey. If the Waveguide Refractive Index is set equal to the Layer Refractive 
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Index, the waveguide will disappear in this layer, as in the third layer of the 
Layer Structure dialog box above.

5 Click the OK button to enter the new values and display the new structure in 
the Layer Structure dialog box.

Adding a layer

The Layer Structure dialog box can also be modified by adding and deleting layers.   For 
example, the effect of etching deeper into the wafer can be modelled by making the substrate 
layer thinner and adding another layer.

To add a layer, perform the following procedure.

Step Action 
1 In the Effective Index Calculator dialog box, click the layer which will be below 

the new layer.

2 Click Add

3 Click on the new layer, and then on Edit to modify the thickness and indices.

After making the layer below thinner by 0.1 microns, the structure with the 
additional etching can be modelled (see Figure 5).
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Figure 5 Layer structure with additional etching

Performing effective index simulations

In this step, you will perform effective index simulations using the Weighted Index Method of 
the waveguide you have designed. They will result in a transformation of the 2D waveguide 
refractive index into a 1D effective index distribution.

To perform the effective index simulations, perform the following action.

Action 
• In the Layer Structure dialog box, click the Calculate button.

Note: Notice that, after the effective index simulations, the waveguide 
structure has been transformed to a 1D effective index distribution. The data 
from the effective index simulation can be used directly in the WDM design 
as default parameters for the wafer and the waveguide. This means that you 
can press the Close button and go directly to Step 1 of Lesson 2.

If the structure shown in the first Layer Structure dialog box is used, the equivalent waveguide 
should look like the one in the picture below. The rib (or buried waveguide structure) is replaced 
by a symmetric slab guide (see Figure 6).
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Figure 6 Waveguide

Showing results of the modal index calculation

This step will show the result of the modal index calculation using the Weighted Index Method 
to find all the modes supported by the guiding structure. Then, you will learn how to display the 
modal field distribution and the refractive index distribution.

To find the modal indices of the guided modes, perform the following action.

Action 
• In the Mode Calculator dialog box, click Modes.

The Modal Indices dialog box appears (see Figure 7).
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Figure 7 Modal Indices dialog box

Note: In the Modal Fields dialog box, you see a list of the modal indices. 
Since the waveguide you have designed is monomode, there is only one 
item in the list.

Viewing the modal field distribution and effective index distribution

To view the modal field distribution and the effective index distribution, perform the following 
procedure.

Step Action 
1 In the Modal Indices dialog box, click the mode in the list to select it.

2 Click the Display Field button.
At the end of this step, you should be able to view the modal indices of the 
waveguide, the modal field distribution, and the effective index distribution 
(see Figure 8).
35



COMPONENT LIBRARY  LESSON 1: EFFECTIVE INDEX CALCULATIONS
Figure 8 Modal field distribution and effective index distribution

3 A right mouse button click in the graph area of the Field Display dialog box 
will bring up a menu with more display options (see Figure 9). These options 
can be used to modify the display, get tabular data about the curves, modify 
colors, add grids, labels, or print the graph.
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Figure 9 Display options
37



COMPONENT LIBRARY  LESSON 1: EFFECTIVE INDEX CALCULATIONS
Notes
38



COMPONENT LIBRARY  LESSON 2: DESIGN A WDM DEVICE WITH THE WIZARD TOOL
Lesson 2: Design a WDM device with the Wizard 
Tool

In this lesson, you will use the Wizard Tool to create a WDM device.

Closing dialog boxes to access the Initial Data dialog box

At the end of Lesson 1, you have opened the Effective Index Calculator dialog box, the Modal 
Fields dialog box, and the Field Display dialog box. In this step, you will close those dialog 
boxes to access the Initial Data dialog box in which you will further define the parameters of 
your WDM design and simulations.

Since you have already calculated the data regarding the effective indices and entered the 
waveguide width and the wavelength in the previous lesson, you will now enter only the data 
regarding the length and the width of the wafer and the number of points per micron for BPM 
simulations.

To enter data in the Initial Data dialog box, perform the following procedure.

Step Action 
1 Close the Field Display dialog box.

2 In the Modal Indices dialog box, click the Close button.

3 In the Mode Calculator dialog box, click the Close button. The Initial Data 
dialog box will appear (see Figure 1).
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Figure 1 Initial Data dialog box

4 In the Wafer section, type 15000 in the Length (Propagation) box.

5 In the Wafer section, type 10000 in the Width box.

6 In the Number Of Points Per Micron box, type 20.

7 Click the OK button.
At the end of this step, you should be able to see the Wafer work space on 
your screen .

Creating a WDM device using the Device Wizard

In this step, you will use the Device Wizard command available in the Design menu of the WDM 
- Device Layout Designer dialog box. You will start creating a WDM device using the Wizard 
windows.

Defining the required polarization and crosstalk level

To define the required polarization and crosstalk level, perform the following procedure.

Step Action 
1 From the Design menu, click Device Wizard.

2 In the WDM Parameters dialog box, enable the TM button in the Polarization 
section. This is required because the effective index calculation (in the 
transverse plane) had a TE polarization, but the simulations of the array are 
in the epitaxial plane. Therefore the sense of direction is reversed, and the 
polarization is opposite (see the Technical Background section of the 
manual).

3 In the Maximum Crosstalk Level (dB) section, enter the value of -35 in the 
Input/Output Waveguides box and the Phased Array Waveguides box.

4 Click the Next button.
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Note: Make sure that you have the same data entered in the WDM 
Parameters dialog box as the data in Figure 2.

Figure 2 WDM Parameters dialog box
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Define nonuniformity of output channels and the number of output 
channels

In this step, you will work in the next Wizard window. It contains data regarding the Minimum 
Waveguide Separation, which has been calculated on the basis of the Crosstalk Level 
requirements, and the waveguide modal properties defined in the previous window. At the 
bottom of this Wizard window, you will find information about the input/output parameters of the 
waveguides.

To enter output channels data, perform the following procedure.

Step Action 
1 In the Nonuniformity box, make sure the value entered is 0.5 (see Figure 3).

2 In the Output Channels box, type 8 (see Figure 3).

3 Click Next.
Note: The Free Propagation Region Effective Index can be assigned a value 
which is different from the value for the Waveguide Effective Index. In this 
particular example, however, you are using the same value.

Figure 3 Changing nonuniformity and output channels
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In this Wizard window, you can see the calculated results for the Minimum Length of the Free 
Propagation Region. The Minimum Length and the Far-Field-Half Angle values are displayed 
in the top section of the Wizard window. The calculation of those results is based on the 
requirements for the number of output channels, nonuniformity, and the waveguide and wafer 
parameters.

4 Press the Next button.

In the Wizard window in Figure __ , you see a summary of the most important 
WDM geometric and modal parameters that are calculated based on your 
requirements for waveguide and wafer properties, crosstalk level, 
polarization, number of output channels and nonuniformity. Array 
transmission and device dispersion.

Figure 4 Summary of parameters

5 Click the Finish button.
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At the end of this step, WDM_Phasar will display automatically the WDM 
device, shown in the picture below:

Figure 5 WDM device

This design can be saved using the File drop down menu. In the Samples directory of 
WDM_Phasar, this design is already saved as Lesson2.wdm.
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Lesson 3: Editing the WDM device geometry
In this lesson, you will get acquainted with the options available in the WDM Device Properties 
dialog box. You can use this dialog box to edit the WDM Device geometric and material 
parameters. The WDM Device Properties dialog box contains seven tabs that allow you to view 
and define the parameters of the different components of the WDM device. For the parameter 
naming conversion, see Appendix I (WDM_Phasar Atlas).

To start this lesson where Lesson 2 ended, open the file Lesson2.wdm.

Using the WDM Device Properties dialog box

In this step, you will open the WDM Device Properties dialog box in which you can edit the input 
port parameters. In the Connection Offset box, you can define the distance between the wafer 
edge and the first waveguide centre; in the Port separation frame, you can define the distance 
between individual waveguide centres. There is also a check box to enable the use of Optimum 
Waveguide Offset. This feature can be used in the input, output, and phased arrays. When 
enabled, an offset is added at the junctions between straight and curved waveguides to 
minimize the radiation loss there. See the sections Propagation Constant of Bent Waveguides, 
Optimum Offset, and Bent/Straight Junction Loss in the Technical Background chapter of this 
manual for further details.

Accessing the WDM Device Properties dialog box

To access the WDM Device Properties dialog box, perform the following procedure.

Step Action 
1 Select the device by clicking in the wafer and dragging the cursor to enclose 

at least part of the device in a selection box.

2 From the Edit menu, click Properties.
By default, the Input tab is enabled, and you see the data entered in the boxes 
on the Input page.

Note: For the purposes of this lesson, you don't have to change the default 
values on the Input page (shown below).
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Figure 1 WDM Device Properties — default values

Notice that the Symmetrical Couplers check box is enabled, that is, the Phased Array is 
symmetric and the Output Star Coupler is a mirror image of the Input Star Coupler. For more 
information about input ports, see Appendix 1 in this manual.

Parameters of the Input Selection of the Input coupler

In this step, you will access the parameters of the Input Section of the Input Coupler. On the I/O 
Section page, you can edit the following parameters:
• Radius box — Radius of the input surface of the Free Propagation Region
• Number Of Waveguides box — Number of waveguides
• Minimum Waveguide Separation box — Separation from one waveguide centre to the 

centre of the adjacent waveguide. These separations can be the same for all waveguides, 
or a non-uniform spacing can be specified.

• Waveguide Length box — Length of the I/O Section waveguide (the waveguide 
connected to the coupler)

• Waveguide Effective Index boxes — Real and the imaginary values. The waveguides 
need not have the same index.

• Tapered Entry section (when enabled) — Tapered start and end width and the length of 
46



COMPONENT LIBRARY  LESSON 3: EDITING THE WDM DEVICE GEOMETRY
the tapers, as well as the type of taper.

Accessing data on the I/O Section page

To access the data on the I/O Section page, perform the following action.

Action 
• In the WDM Device Properties dialog box, click the I/O Section tab.

Figure 2 I/O Section tab

For the purposes of this lesson, you don't have to change the default values, shown on the 
picture above.

For more information, see the Input Section, Input Coupler section in Appendix I in the 
WDM_Phasar Parameter Atlas.
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Input Star Couplers parameters
In this step, you will access the parameters of the Input Star Couplers. On the I/O Coupler page, 
you can edit the values of the Free Propagation Region of the Input Coupler. You can define the 
following parameters:
• Tip Position boxes — Position of the lower tip
• Coupler Length box — Length of the Free Propagation Region element
• Orientation Angle box — Angle between the horizontal axis and the central line of the 

Free Propagation Region
• Angular Width box — Angular opening of the Free Propagation Region seen from the Tip
• Effective Index boxes — Real and imaginary values

Accessing the data on the I/O Coupler page

To access the data on the I/O Coupler page, perform the following action.

Action 
• In the WDM Device Properties dialog box, click the I/O Coupler tab.

Figure 3 I/O Coupler tab
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For the purposes of this lesson, you don't have to change the values, shown of the picture 
above.

For more information, see the Input Coupler, Free Propagation Region section in Appendix I of 
the WDM_Phasar Atlas.

Parameters of the Phased Array Section of the I/O Coupler

In this step, you will access the parameters of the Phased Array Section of the Input/Output 
Coupler. On the I/O PA Section page, you can edit the following parameters:
• Radius box — Radius of the output surface to the Free Propagation Region
• Number of Waveguides box — Number of the waveguides
• Minimum Waveguide Separation box — Separation from waveguide centre to 

waveguide centre (see Appendix 1)
• Waveguide Length box — Length of the phased array waveguide connected to the 

coupler (see Appendix 1)
• Waveguide Width box — Width of the waveguide
• Waveguide Effective Index boxes — Real and the imaginary values
• Tapered Entry section (when enabled) — Tapered start and end width and the length of 

the tapers

Accessing the data on the I/O PA Section page

To access the data on the I/O PA Section page, perform the following procedure.
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Action 
• In the WDM Device Properties dialog box, click the I/O PA Section tab.

Figure 4 I/O PA Section tab

For the purposes of this lesson, you don't have to change the default values, shown on the 
picture above.

For more information, see the Phased Array Section, Input Coupler section in Appendix I of the 
WDM_Phasar Atlas.
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Phased Array Section parameters
In this step, you will access the parameters of the Phased Array Section. On the PA page, you 
can edit the following parameters:
• Waveguide Effective Index boxes — Real and the imaginary values
• Number of Waveguides box — Number of the waveguides
• Waveguide Width box — Width of the waveguide
• Length Increment box — Length increment with respect to the previous path
• Initial Length Increment box — Difference between the distance between the couplers 

and the length of the first path.

To access the data on the PA page, perform the following action.

Action 
• In the WDM Device Properties dialog box, click the PA tab.

The buttons in the Path Template section allow you to use any of the four 
templates.

Figure 5 PA tab
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For the purposes of this lesson, you don't have to change the data on the PA page, shown on 
the picture above.

For a detailed description of the Phased Array, see the Phased Array Section, Input Coupler 
section in Appendix I of the WDM_Phasar Atlas.

For more information about using the path templates, see Appendix II of the WDM_Phasar 
Atlas.

Output Port parameters

In this step, you will access the parameters of the Output Ports. On the Output page, you can 
edit the following parameters:
• Connection Offset box — Distance from the edge of the wafer to the centre of the first port 

waveguide
• Port Separation frame — Difference between centres of the waveguides. The separation 

can be a uniform or non uniform spacing.

Accessing data on the Output page

To access the data on the Output page, perform the following action.
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Action 
• In the WDM Device Properties dialog box, click the Output tab.

Figure 6 Output tab

For the purposes of this lesson, you don't have to change the default data on the Output page, 
shown on the picture above.

For a detailed description of the output ports, see the Output Ports section in Appendix I of the 
WDM_Phasar Parameter Atlas.
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Lesson 4: Tools for fast evaluation of WDM 
device performance

In this lesson, you will learn how to use the following tools for fast evaluation of the WDM device 
performance: Device Statistics, Statistics Monitor, and Performance Calculator.

Commands available in the Performance menu

In this step, you will access the statistics information regarding the Phased Array, the Input 
Array, and the Output Array by using the commands available in the Performance menu.

Accessing the Phase Array statistics

To access the Phased Array statistics, perform the following procedure.

Step Action 
1 Make sure the device is selected.

2 From the Performance menu, click Device Statistics, Phased Array. After the 
calculation of the Phased Array is completed, the Phased Array Statistics 
dialog box appears. The statistics for the Phased Array are shown. The first 
column shows if the geometry allowed the waveguide path to be drawn. The 
second estimates the losses in the path from bending and junctions. The last 
shows the closest the waveguide gets to a neighbor while in the Phased 
Array. This does not include the Phased Array Section near the couplers (see 
the WDM Atlas for the precise definition of these terms).

3 In the Phased Array Statistics dialog box, enable the Display The Crosstalk 
Level check box. WDM Phasar recalculates the exact maximum Cross-talk 
level that corresponds to the given minimum separation distance.
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Figure 1 Phased Array Statistics dialog box

4 Click the Close button.

• TIP: To access the Phased Array Statistics dialog box, you can also click the PA 
Stats button on the WDM Device toolbar (the third button on the toolbar 
shown below).

Figure 2 WDM Device toolbar — PA Stats button
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Accessing the Input Array statistics

To access the Input Array statistics, perform the following procedure.

Step Action 
1 From the Performance menu, click Device Statistics, Input Array.

Figure 3 Input Array Statistics dialog box

2 Click the Close button.

• TIP: To access the Input Array Statistics dialog box, you can also click the IA 
Stats button on the WDM Device toolbar (the fourth button on the toolbar 
shown below).
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Accessing the Output Array statistics

To access the Output Array statistics, perform the following procedure.

Step Action 
1 From the Performance menu, click Device Statistics, Output Array.

Figure 4 Output Array Statistics dialog box

2 Click the Close button.

• TIP: To access the Output Array Statistics dialog box, you can also click the OA 
Stats button on the WDM Device toolbar (the fifth button on the toolbar 
shown below).

Figure 5 WDM Device toolbar — OA Stats button
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Summary of calculated parameters
In this step, you will get a summary of calculated parameters of the Phased Array, the Input 
Array, and the Output Array. You will accomplish this by using the Statistics Monitor dialog box.

Obtaining a summary of device statistics

To obtain a summary of the device statistics, perform the following procedure.

Step Action 
1 From the Performance menu, click Statistics Monitor.

The Statistics Monitor dialog box appears (see Figure __).

Figure 6 Statistics Monitor dialog box

2 Click the Recalculate Now button.
The Statistics Monitor displays an information summary regarding the 
Phased, Input, and Output Arrays.

3 Close the Statistics Monitor dialog box.

Note: If the Auto Recalculation button is enabled, WDM_Phasar will 
recalculate the parameters that are selected whenever related parameters 
from the WDM device are changed.

• TIP: To access the Statistics Monitor dialog box, you can also click the Stats Mon-
itor button on the WDM Device toolbar (the sixth button on the toolbar shown 
below).

Figure 7 WDM Device toolbar — Stats Monitor button
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Compute the performance characteristics of the device
In this step, you will use the Performance Calculator to compute the performance 
characteristics of the device. In the Performance Calculator dialog box, you will find a summary 
of the most important geometric, material, and modal properties of the WDM device.

You will also calculate the most important performance characteristics of the device--Phasar 
Order, Dispersion, Free Spectral Range, Channel Nonuniformity, Spacing, Bandwidth, and 
Diffraction Loss — which will be displayed in the Results dialog box.

Calculating the device performance characteristics

To use the calculate the device performance characteristics, perform the following procedure.

Step Action 
1 From the Performance menu, click Performance Calculator.

2 The Bandwidth Level is used to define the widths of channels. To report 3 dB 
levels, enter -3 in this box. -20 defines the widths for a 20 dB level.

Figure 8 Performance Calculator dialog box

3 Click the Compute button.
After the calculation is performed, the Result dialog box appears. It provides 
a summary of all input information and a summary of the calculation results 
of that information.
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Figure 9 Result dialog box

4 To save the calculation results, click the Save button.

5 In the Save As dialog box, choose a folder where you want to save the 
information and type a name in the File Name box.

6 Click the Save button to save the results and close the Save As dialog box.

7 Click the Close button to close the Result dialog box.

8 Click the Close button to close the Performance Calculator dialog box.
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Lesson 5: BPM simulation
In this lesson the light passing through the phasar array will be simulated for a fixed wavelength.

Define parameters to control BPM simulation

In this step, you will define the parameters to control the BPM simulation of the input and output 
couplers.

Setting the BPM parameters

To set the BPM parameters, perform the following procedure.
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Step Action 
1 From the Simulation menu select BPM Data.

2 Set the polarization to TM.

3 In the number of displays box, type 50.

4 In the propagation step box, type 1.55.

5 In the Input Port frame, select which port you would like the input light to enter 
the device (4).

6 Select the wavelength of light for this simulation (1.55 mm).
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Setting the input and output coupler simulation range

To set the input and output coupler simulation range, perform the following procedure.

Step Action 
1 From the Simulation menu select BPM Data.

2 Select the Input Coupler Simulation Range tab.

Figure 10 BPM Data — Input Coupler Simulation Range tab

3 Click on the Get Default button to set the input range to the maximum extent 
possible.

4 Repeat step 3 for the Output Coupler Simulation Range.

5 Click OK to close the box.

A shorter distance will reduce the execution time of the simulation. Pressing 
Calculate next to the Crosstalk level box will show the expected level of 
crosstalk between waveguides at this point, based on an estimate from an 
overlap integral. The distance should be set large enough that coupling can 
be neglected outside the region of BPM simulation.
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Clicking on Calculate next to the Crosstalk Level will show the result of the 
overlap integral with the distance shown in the corresponding Distance box.

It is possible to use this feature in the opposite direction, you can type a value 
into Crosstalk level (between -10 and -200 dB), and click on the Calculate 
button next to the Distance box. The computer will then calculate 
(approximately) the corresponding distance.

Running the simulation and view the results

In this step, you will run the simulation and view the results. To run the simulation, perform the 
following procedure.

Step Action 
1 From the Simulation menu select Calculate.

Figure 11 BPM Data dialog box — calculate

2 Click on Run to start the simulation. The simulator will pop up the following 
windows which will display the fields as the calculation progresses.
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Figure 12 Calculation — progress

The top left quadrant displays a topographical view of the optical field. The top right quadrant 
displays a 3D view of the optical field. The bottom left quadrant displays a cross-sectional view 
of the effective index distribution (in red) and the field distribution (in blue). The bottom right 
quadrant displays a 3D view of the effective index.

After the calculation is finished, the windows show the light after crossing the output coupler.

Figure 13 Calculation — light after crossing the output coupler
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After the simulation is finished, any of these windows can be expanded to fill the whole window 
by selecting the desired window and pressing F2. Click the right mouse button to pop up a menu 
with further display options.
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Lesson 6: Parameter scanning
In Lesson 6, you are going to define parameters for scanning. You will assign the range of the 
parameter values and the number of simulation steps. Any parameter marked with an asterisk 
in the dialog boxes can be scanned. In this example, the wavelength is assigned as the scan 
variable, and the power in each output port is plotted as a function of wavelength at the input 
port. In this way the device can be evaluated as a multiplexer/demultiplexer.

Define the initial value of the parameter

In this step, you will define the initial value of the parameter to be scanned by using the BPM 
Data dialog box. More specifically, you are going to scan the wavelength which is crucially 
important for the analysis of the performance of a (de) multiplexer. In this step, instead of a fixed 
value, you will define a variable name ("wl") for the wavelength.

Entering the initial value of the parameters to be scanned

To enter the initial value of the parameters to be scanned, perform the following procedure.

Step Action 
1 From the Simulation menu, click BPM Data.

2 In the BDM Data dialog box, type "wl" in the Wavelength box.
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Figure 1 BPB Data dialog box — wavelength

3 Click the OK button to open the Parameter dialog box.

4 In the Parameter dialog box, type 1.546 in the Value box.
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Figure 2 Parameter dialog box

5 Click the OK button to close the Parameter dialog box and the BPM Data 
dialog box. This sets the starting value of the scanned parameter.

Define the number of simulation steps and end value

In this step, you will further define the number of simulation steps and the end value of the 
parameter.

Defining parameters

To define parameters in the Scan Parameters dialog box, perform the following procedure.

Step Action 
1 From the Simulations menu, click Scan Parameters.

2 In the Scan Parameters dialog box, double-click the name of the parameter 
that appears in the Unassigned Parameters box.
The parameter is added to the first column in the bottom section of the dialog 
box.

3 In the Number Of Iterations section, type 121 in the box.

4 Click the Apply button.
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Figure 3 Scan Parameters dialog box
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Define parameter values and assign a leading parameter
In step 3, you are going to define parameter values and assign a leading parameter. The 
leading parameter is the one which will be used on the x-axis when the results are plotted. (You 
can, if you like, make other variables vary with the leading one).

Defining the wavelength parameters

To define the wavelength parameters to be scanned, perform the following procedure.

Step Action 
1 In the Scan Parameters dialog box, scroll down using the mouse until you get 

to row #121.

2 In the column next to 121, type 1.555.

3 Click the top of the "wl" column to select it.

4 Click the Fill button to fill up the table with equidistant values between 1.546 
and 1.555 in 121 iteration steps.

Figure 4 Scan Parameters dialog box — Fill table
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Assigning a leading parameter

To assign a leading parameter, perform the following procedure.

Step Action 
1 In the Scan Parameters dialog box, click the Assign button to assign the 

parameter "wl" as the leading parameter.

2 Click the OK button to open the Scanning Options dialog box.

Figure 5 Scanning Options dialog box

3 In the Scanning Options dialog box, click the Don't Check button.

Note: If you scan a geometric parameter, you may encounter ranges in which 
the device does not exist, due to the constraints of geometry. You can use the 
Display button and the Silent button in the Scanning Options dialog box for a 
preview when you want to scan a geometric parameter.

Define simulation results to save

In step 4, you are going to define which simulation results will be saved.

To define the output data files in which the simulation results will be saved, perform the following 
procedure.

Step Action 
1 From the Simulation menu, click Output Data Files.

The Output Data Files dialog box appears (see Fig __).
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Figure 6 Output Data Files dialog box

2 In the Output Data Files dialog box, enable the Power In Output Ports check 
box.

3 Disable the Auto Output File Names checkbox.

4 Click the OK button. The data about the power in the output ports will now be 
sent to the file shown in the box, in ascii format.

Set up parameters for full scanned simulation

In this step, you will set up the parameters for the full scanned simulation. Then, you are going 
to run the simulation.

Note: You may want to let your computer do this calculation overnight, or some time when 
the processor is not in high demand.

Running the scanned simulation

To run the scanned simulation, perform the following procedure.

Step Action 
1 From the Simulation menu, click Calculate.

2 In the Number Of Displays box, type 50.

3 In the Propagation Step section, type 1.
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Figure 7 BPM Data dialog box — calculation

4 Click the Run button.
The WDM Device Simulator dialog box appears.

Note: You can stop the calculations at any time by pressing the Pause 
Calculation button (the first button on the Calculations toolbar). To resume the 
calculations, press the Resume The Actual Calculations button (the second 
button on the Calculations toolbar).

Figure 8 Calculations toolbar

At the end of this step, the following run time graphics appear which are 
displayed in four quadrants:
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Figure 9 Run time graphics

The top left quadrant displays a topographical view of the optical field; the top right quadrant 
displays a 3D view of the optical field; the bottom left quadrant displays a cross-sectional view 
of the effective index distribution (in red) and the field distribution (in blue); the bottom right 
quadrant displays a 3D view of the effective index. The Report box you see in the middle 
displays some of the most important parameters during the simulations.

In the next stage of the simulation process, the quadrants on the screen display the same 
information about the propagation in the Output Coupler.
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Figure 10 Propagation in the Output Coupler

At the end of the first run (for the first wavelength), two more graphics will appear at the bottom 
of the WDM_Device Simulator dialog box, as shown below.

Figure 11 End of first run

The left-hand quadrant (Field Amplitude & Effective Index) shows the effective index and the 
field distributions in the end of the propagation for all eight channels; the right-hand quadrant 
(Output Power VS Scan Parameter) shows the Output Power (dB) for all eight channels.

Note: For each wavelength run, the program adds one point to the eight curves on the right-
hand graphics. It might take several hours to complete the simulations.
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• TIP: Once the simulations are performed, you can enlarge the graphic showing 
the output power in the channels, as shown below, since it contains the most 
important results. Click the right mouse button on this graph to bring up a 
menu, and select the axis option to adjust the scales for convenient viewing.

Figure 12 Output Power vs Scan Parameters

Summary of device performance

In this step, you will get a summary of the device performance: amplitude (in dB), width, 
spacing, and cross-talk level for all eight channels.

Obtaining a summary of the device performance

To obtain a summary of the device performance, perform the following procedure.

Step Action 
1 Right-click in the Output Power VS Scan Parameter dialog box and from the 

pop-up menu choose Statistics.

2 Carefully review the information in the Statistics dialog box.
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Figure 13 Statistics dialog box

• TIP: To change the level of measuring of the bandwidth, type a value in the Band-
width Level box and click the Recalculation button.
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Example 1: Tapered waveguides in the phased 
array

Reference files: TaperReference.wdm, Taper.wdm

The insertion loss of phasar arrays can be reduced by tapering the waveguides at the ends of 
the phased array. Consider the end of the input coupler in the file TaperReference.wdm. When 
the light gets to the end of the input coupler, it is almost a plane wave that must be launched 
into waveguides. The optical fields of the waveguides overlap somewhat, but still there will be 
losses as some of the light will fail to enter the waveguide modes.

Figure 1 Phasar arrays

The losses can be reduced by tapering the ends of the waveguides. This makes a smoother 
transition, as seen in Taper.wdm:
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Figure 2 Tapering the ends of the waveguides

The tapers are created by first selecting the device, and then opening the WDM Device 
Properties dialog box (Edit>>Properties…>>I/O PA Sect.). Enable the Tapered Entry checkbox, 
and enter the refractive index of the tapered waveguide, its length and starting and ending 
widths. The taper can be linear, parabolic, or exponential. The parabolic taper is specified from 
these data by setting the slope of the boundary tangent to the connecting waveguide. The 
exponential taper is not constrained this way, but needs the user to specify the constant (called 
"alpha") used in the exponential.
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Figure 3 Creating the tapers

In TaperReference.wdm, the distance between the waveguides at the coupler was 3.0, so 
setting the start width to 3.0 completely fills the end of the coupler.

The simulator is run for both Taper.wdm and TaperReference.wdm, and the results 
compared. TaperReference.wdm is shown in black dotted lines and Taper.wdm in red solid 
lines. The taper doesn't change the device performance, except for the insertion loss, which is 
reduced equally for each channel and wavelength.
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Figure 4 Comparing simulation results — TaperReference.wdm and Taper.wdm
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Example 2: Tapers in the output waveguides 

Reference files: TaperFlatRef.wdm, TaperFlat.wdm

A taper in the output waveguide can also reduce the insertion loss. This taper will increase the 
effective width of the receiver, which will increase the range of wavelengths coming into the 
channel. This is an advantage in the case where a wider bandwidth of the signal channel, or a 
flatter passband, is desired. For example, the two phasar arrays above are identical except that 
the second one has tapered output waveguides:

Figure 1 Phasar array with tapered output waveguides

These tapers are made by using the WDM Device Properties box (Edit>>Properties…>>I/O 
Sect.). Enable the Tapered Entry checkbox, and enter the refractive index of the tapered 
waveguide, its length and starting and ending widths. The taper can be linear, parabolic, or 
exponential. The parabolic taper is specified from these data by setting the slope of the 
boundary tangent to the connecting waveguide. The exponential taper is not constrained this 
way, but needs the user to specify the constant (called "alpha") used in the exponential. Here 
the linear taper has been used.
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Figure 2 Linear taper used as the constant

The result of the simulation is shown for the two phasar arrays. The curves centred at 1.553 
show the power in the 3rd (centre) output waveguide. The dotted line is the phasar device with 
untapered waveguides. The solid line shows the effect of the taper. The overall insertion loss is 
reduced, but also the bandwidth of the channels is increased.

Figure 3 Simulation results for the two phasar arrays
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Example 3: Phased array corrections

Reference files: PAcorRef.wdm, PAcorAdv.wdm

The BPM Data dialog box has a button called Edit PA Corrections which allows the phase and 
amplitude of the light at the end of the phasar array to be modified. The BPM Data dialog box 
is reached from the Simulation menu. This feature may be useful if there is some special 
circumstance that modifies the optical phasars in a known way, and the response of the device 
needs to be modelled. This feature can also be used to model the effects of fabrication errors 
in the array, as the effects of a given phase error can be investigated by adding random phases 
of a given distribution.

Figure 4 BPM Data dialog box — Edit PA Corrections

Clicking on Edit PA Corrections brings up the following box.
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Figure 5 Edit Amplitude & Phase Corrections dialog box

At the end of each phasar waveguide, the optical phasar will be multiplied by the complex 
number shown in the box. The default value is 1+0j, so by default this box does nothing.

In the example PAcorRef.wdm, a phasar array is simulated with the following output.

Figure 6 Simulated phasar array — PAcorRef.wdm

Most of the optical power goes to the second output channel. The situation in the output coupler 
is shown below.
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Figure 7 Situation in output coupler

This example will show how to modify the optical phase and amplitude in the phasar array 
directly. By adding the correct phase advance to each of the 14 waveguides in the phased array, 
the power can be redirected to output channel 4.

The length of the coupler is 116.73 mm, and the spacing between the waveguides is 3.0 mm. 
To move the power to channel 4, a deflection of 6 mm is needed. Since the length of the coupler 
is much longer than the deflection, the curvature of the input and output aperture planes can be 
neglected. The necessary phase advance can be found from a diagram of adjacent waveguides 
at the junction with the coupler.
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Figure 8 Phase advance

The path length is longer for the lower PA waveguide by a length, p. Therefore the lower 
waveguide must have a phase advance over the upper one. The length is

The wavelength inside the coupler is

The phase advance is calculated by comparing this wavelength to the path difference

If waveguide 14 is kept the same, then the above phase should be added to waveguide 13. 
Waveguide 12 needs , and so on. 

PAcorAdv.wdm is the same as PAcorRef.wdm except that the Edit Amplitude and Phase 
Corrections dialog box has the phase corrections as described above.

p 3 θ 30 3 6( )
116.73
----------------≈ ≈sin 0.1542µm= =

λg λ nFPR⁄ 1.55 3.332⁄ 0.465= = =

φ 2π p
λg
----- 2.08267= =

2φ
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Figure 9 Phase corrections for PAcorAdv.wdm
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When a simulation is run from PAcorAdv.wdm, the result of the calculation shows the power 
moves to the fourth channel, as expected.

Figure 10 Result of the simulation calculation

The amplitudes of the optical phasars in the phasar array may be modified as well, if desired.
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Example 4: Phased array with variable 
increment in the path length

Reference file: VarIncr.wdm

The phasar array in VarIncr.wdm has the path number index in the specification of the length 
increment. This allows the length increment to be specified by a user defined formula. A simple 
example is shown in the WDM Device Properties box (Edit>>Properties…) of the file 
VarIncr.wdm.

Figure 1 Example of VarIncr.wdm

The actual lengths of the waveguides in the phased array can be seen in the Device Geometry 
dialog box (Performance>>Device Statistics>>Device Geometry…>>Phased Array)
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Figure 2 Device Geometry dialog box
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To get the path increment for the second waveguide, the program calculates the length 
increment for path 2 as

Then this increment is added to the first path length, 7429.266, to get the length of waveguide 
2, 7582.017. The difference between this value and the one shown in the box is due to the 
precision (tolerance) of the WDM_Phasar layout, which is about ±10nm.

The path increment for the later waveguides is calculated in a similar way.

148.751 2∗ 2+ 152.751=
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Notes
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Example 5: Polarization independent device by 
splitting the input

Reference files: PolSplitTE.wdm, PolSplitTM.wdm

The response of a simple phasar array will depend on the polarization of the light. The 
dependence is a result of the dependence of the modal index of planar waveguides on 
polarization. One way to reduce the effect of the polarization of the input light is to split the input 
signal into horizontal and vertical components before it is sent to the device. The separated 
horizontal and vertical waves are sent to separate input ports on the device. When they enter 
the separate planar waveguides, the vertical waves become TM waves and the horizontal ones, 
TE. The TE and TM waves have different propagation constants on the waveguides, so they 
accumulate different phases on the phased array, and (in general) focus to different spots at the 
end of the output coupler. However, the position of the focus at the end of the output coupler 
also depends on the position of the input waveguide at the beginning of the input coupler. It is 
possible to arrange the position of the input waveguide of the TE waves and the position of the 
input waveguide of the TM waves in such a way that they will arrive at the same spot at the end 
of the output coupler.

Figure 1 TE and TM waves

The difference in the optical phase accumulated by the TE and TM waves is compensated by 
the different angle of incidence of the TE and TM waves at the end of the Input Coupler (the 
beginning of the phased array). See Smit and VanDam, IEEE Journal of Selected Topics in 
Quantum Electronics, 2(2) p243 (1996) for a discussion of this strategy.
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As an example, consider the rib waveguide of width  at  below.

Figure 2 Rib waveguide

The calculation of the modal index of the fundamental mode by the Weighted Index Method is 
3.300759 for TE polarization, and 3.292291 for TM.

In PolSplitTE.wdm, the TE modal index is entered directly through the User Defined PA 
Waveguide Modal Idx frame of the BPM Data dialog box.

3µm λ 1.55µm=
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Figure 3 TE modal index

When this simulation is run, the focal point at the far side of the output coupler can be found. 
Running the same simulation with the TM modal index (and changing the polarization to TE in 
the Polarization frame) will show where a TM wave would focus, some distance from the TE 
focus. Since the device is symmetric, displacing the input by the same distance (11.5 mm) will 
give the same focal point for both TE and TM.

In PolSplitTM.wdm, the TM path is simulated. Both paths are simulated and scanned in 
wavelength from 1.546 to 1.553 mm. VIEW2D is used to load both .piw files, to compare the 
TE and TM response.
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Figure 4 Comparison of TE and TM response

From the above graph we can see that, for example, input light of wavelength 1.550 mm, 
whether it is horizontally or vertically polarized, will go mostly to the second output channel, with 
only a small fraction (-20 dB) going to the adjacent channels.
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Example 6: Triangular region in the phased array

Reference files: Triangle.wdm, NoTriangle.wdm

The phasar array in NoTriangle.wdm has four output channels spaced at 0.81 nm. As can be 
seen from running the simulator, light with  starts from input channel 3 and 
goes to output channel 2.

Figure 1 Light from input channel 3 to output channel 2

Decreasing the wavelength by 0.81 nm changes the deflection to send the light to output 
channel 3. The switching can also be induced by a physical change in the waveguide instead 
of a change in wavelength, as the output is a sensitive function of the propagation constant of 
the array waveguides.

The optical phase in the ith waveguide of length Li is:

(1)

where n is the modal index of the waveguides.

λ 1.55464µm=

ϕ i knLi=
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The effect of a change in wavelength on the phase of these waveguides is:

(2)

Suppose the material index of refraction in the waveguide and substrate can be increased by 
, (by an electro-optic effect, for example), and that this effect applies on part of the length 

of each waveguide. For small changes in index, the modal index will change by about the same 
amount as the material index. Let the fraction of distance on each waveguide where the index 
is changed be represented by the dimensionless parameter, x. The change on the optical phase 
due to the change in refractive index is:

(3)

In order to simulate a change in wavelength by a change in refractive index, the change should 
be applied over a limited fraction of the total length of the waveguides, x. By equating Equation 
2 and Equation 3,

(4)

Suppose the change in index of the core and cladding of the equivalent waveguide is 
. In NoTriangle.wdm, the modal index is 3.313 (this number can be seen in grey 

in the BPM Data dialog box). Using the values of  and  above gives the required fraction 
of length to apply the change in index, x = 0.173.

The Phased Array tab of the Device Geometry box (reached from Performance>>Device 
Statistics>>Device Geometry>>Phased Array) indicates the length of the first and last 
waveguides in the phased array. These are given as  and  
respectively. The change in index will have the same effect as the change in wavelength if the 
index change is applied for xLi for each of the waveguides . This can be achieved 
by defining a triangular shaped region, as shown in Triangle.wdm. At the top of the phasar 
array, the first and last waveguides are separated by a distance of , so if the apex of 
the triangle is placed the appropriate distance R from the last waveguide, the index change is 
equally graded over the waveguides.

∆ϕ i nLi∆
2π
λ

------ knLi
∆λ
λ

-------–≈=

∆n

∆ϕ i xkLi∆n=

x n∆λ
λ∆n
----------–=

∆n 0.01=
λ ∆λ

L1 7429µm= L14 9363µm=

1 i 14≤ ≤

1614µm
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Figure 2 Index change over waveguides

Solving for R gives  and .

Figure 3 Solution for R

The triangular region is set up in Triangle.wdm. The Triangular Region tab in the WDM 
Device Properties box (Edit>>Properties…) shows the parameters defining the size and 
location of the triangle: the two interior half angles and the offset needed to make the height 
equal to 7814 mm.

R 7814= θ 5.9°=
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Figure 4 Parameters defining size and location of triangle

The modified physical parameters are also shown. The effective index of the wafer inside the 
triangle is increased by 0.01 over the default wafer value, and the correction 0.01 has been 
added to the index of the waveguide itself.

Running the simulation shows that, with the triangular region, the light is diverted from channel 
2 to channel 3.
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Figure 5 Light diverted from channel 2 to channel 3
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Notes
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Figure 6 Overview

Figure 7 WDM Device- Input ports
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Figure 8 WDM Device - Input Coupler
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Figure 9 WDM Device - Output Coupler
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Figure 10 WDM Device - Input Coupler Free Propagation Region (FPR)

Figure 11 WDM Device - Output Coupler Free Propagation Region (FPR)
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Figure 12 WDM Device - Phased Array Section Input Coupler
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Figure 13 WDM Device - Phased Array Section Output Coupler
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Figure 14 WDM Device - Output Ports

Figure 15 WDM Device - Phased Array
114



WDM_PHASAR — APPENDIX 2: PHASED ARRAY TEMPLATES
Appendix 2: Phased Array Templates

Figure 1 WDM Device - Straight Arc Straight template
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Figure 2 WDM Device - Straight Arc template

Figure 3 WDM Device - Arc Straight Arc template
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Figure 4 WDM Device - Arc Straight Arc Straight template
117



WDM_PHASAR —  APPENDIX 2: PHASED ARRAY TEMPLATES
Notes
118





Optiwave   Inc.Systems 
7 Capella Court
Ottawa, Ontario, K2E 7X1 , Canada

Tel.: 1.613.224.4700
Fax: 1.613.224.4706

E-mail: support@optiwave.com
URL: www.optiwave.com


	Table of contents
	Notes

	Effective Index method
	Weighted Index Method
	References
	Notes

	BPM 2D
	Finite-Difference Method
	References
	Notes

	Slab Waveguide Modes
	Phase Accumulation
	Power Overlap Integral
	Waveguide Bend Loss
	Notes

	Propagation constant of bent waveguides
	Optimum Offset
	Bent/Straight Junction Loss
	Wizard Tool
	2D Mode solving
	Cross-talk level
	Free propagation region
	Array waveguide length increment and order of the array
	Aperture width and the number of array waveguides


	Performance Calculator
	Crosstalk level
	Dispersion
	Phasar and modified Phasar order
	Nonuniformity
	References

	WDM_Phasar Tutorials
	Notes

	Lesson 1: Effective index calculations
	Notes

	Lesson 2: Design a WDM device with the Wizard Tool
	Creating a WDM device using the Device Wizard

	Lesson 3: Editing the WDM device geometry
	Using the WDM Device Properties dialog box
	Parameters of the Input Selection of the Input coupler
	Input Star Couplers parameters
	Parameters of the Phased Array Section of the I/O Coupler
	Phased Array Section parameters
	Output Port parameters
	Notes

	Lesson 4: Tools for fast evaluation of WDM device performance
	Commands available in the Performance menu
	Summary of calculated parameters
	Compute the performance characteristics of the device
	Notes

	Lesson 5: BPM simulation
	Define parameters to control BPM simulation

	Lesson 6: Parameter scanning
	Define the initial value of the parameter
	Define the number of simulation steps and end value
	Define parameter values and assign a leading parameter
	Define simulation results to save
	Set up parameters for full scanned simulation
	Summary of device performance

	Example 1: Tapered waveguides in the phased array
	Reference files: TaperReference.wdm, Taper.wdm

	Example 2: Tapers in the output waveguides
	Reference files: TaperFlatRef.wdm, TaperFlat.wdm

	Example 3: Phased array corrections
	Reference files: PAcorRef.wdm, PAcorAdv.wdm

	Example 4: Phased array with variable increment in the path length
	Reference file: VarIncr.wdm
	Notes

	Example 5: Polarization independent device by splitting the input
	Reference files: PolSplitTE.wdm, PolSplitTM.wdm

	Example 6: Triangular region in the phased array
	Reference files: Triangle.wdm, NoTriangle.wdm
	Notes

	Appendix 1: Parameter Atlas
	Appendix 2: Phased Array Templates
	Notes


